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6 Applications of Integration

In this chapter you will ¯nd several activities on various applications of integration. While Sections
6.1 and 6.3 (on area and arc length) follow the same format as previous chapters, and make use of
Mathcad only, Sections 6.2 and 6.4 make use of the Maple V system. The reason for using Maple
is that it o®ers three-dimensional graphing facilities superior to those of Mathcad.

In general, while Maple is more powerful than Mathcad, it is also more di±cult to use. For this

reason you will be provided with Maple documents to serve as templates. This will make it easier
to obtain the desired output (typically, 3-D graphs) without requiring any knowledge of Maple
syntax or programming.

In Calculus II, where numerous topics deal with 3-D objects (curves in space, surfaces, etc.), Maple
will be used more.

6.1 Activity: Area of a Region Between Two Curves

Prerequisites : Read Section 6.1 LHE.

Instructions

After studying the worked example, open a blank Mathcad document and create your report
there. Remember to enter your team's name at the top of the document. Upon completion of
the assignment, enter the names of all team members who actively participated in the assignment.
Save your work frequently.

Example

Use Mathcad's graphing facilities, numerical root ¯nding (root function) and numerical integration
to approximate the area between the graphs of f(x) = x2 ¡ 2 and g(x) = x5 ¡ 3x3 ¡ 2x2.

Solution



72 Chapter 6 Applications of Integration

f( )x x2 2 g( )x x5 .3 x3 .2 x2 x ..,2 1.99 2.2

2 1 0 1 2 3
20

10

0

10

f( )x

g( )x

x

x 1
a root( ),f( )x g( )x x

x 0.5
b root( ),f( )x g( )x x

x 2
c root( ),f( )x g( )x x

=a 1.27

=b 0.653

=c 2.056

Area1 d
a

b

x( )g( )x f( )x Area2 d
b

c

x( )f( )x g( )x

=Area1 2.647 =Area2 6.296

TOTAL AREA: =Area1 Area2 8.943    

Problems

1. Repeat the Example for the area between the graphs of f(x) = sin(2x + 2) and g(x) =
x4 + 2x2 ¡ 1.

2. Repeat for the area of Exercise 33 p.409 LHE.

3. Repeat for the area of Exercise 34 p.409 LHE.

4. Let us suppose you got a job with Calculus City, and your tremendous mathematical skills
made your boss give you the following assignment:

Determine the area of the park under development (see the map in Figure 5), so that the

correct amount of some very expensive grass can be purchased for it.

Of course, generally this wouldn't be an easy problem. This time, however, luck is on your
side. In the city records you ¯nd the following equations (where miles are the units) of the
curves that correspond to the streets bounding the park:

f(x) = x g(x) =
cos(4x)

3
h(x) = ¡ (4x+ 3)3 ¡ 0:7

Now you are ready to solve this problem, using Mathcad to sketch the functions, ¯nd their
intersections (use the crosshair and then the root function), and numerically evaluate the

integral(s) that you properly set up.
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Figure 5: The Calculus City Park map.

6.2 Activity: Volume of a Solid of Revolution

Prerequisites : Read Sections 6.2 and 6.3 LHE.

The objective of this activity is to visually explore the disk (washer) and shell methods for ¯nding
volumes of solids of revolution.

Instructions

To begin this activity, start Mathcad and create a blank document. Remember to enter your team's
name at the top of the document. Upon completion of the assignment, enter the names of all team
members who actively participated in the assignment. Save your work frequently.

From the File menu choose Insert, and select the ¯le DISKMET.MCD. The document you have just

inserted begins with a brief description - read it. (You will see a few de¯nitions of Mathcad functions
and variables; there are quite a few more hidden from your view). The graph in Figure 6 illustrates
the disk (washer) method applied in this particular example. Mathcad's 3-D visualization facilities
are limited - to get a better view of the same objects you will now use the MAPLE V system.

1. Save your Mathcad document, but do not exit from Mathcad.

2. Hold the <Alt> key down, then press the <Tab> key (perhaps more than once) until the
rectangle in the center of the screen says "Program Manager", then release both keys. You
should now see the Program Manager window.

3. Double-click on the "Maple V" icon.

4. Once Maple starts, select Open from its File menu. Load the ¯le DISKMET.MS. Your screen
should now resemble Figure 7.

5. Read the instructions included in the Maple document and ignore the executable statements.
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Figure 6: This picture, from the DISKMET.MCD document, illustrates the disk (washer) method.

When you are ready to execute the ¯le, select Execute Worksheet from the Formatmenu.
After a while, a plot window shown in Figure 8 should appear.

Figure 7: The Maple V main window after loading the template ¯le.

Look at the plot. If you want to get a di®erent view of it, drag your mouse (holding the left button)
inside the plot window, then hit <Enter>. Experiment with it a few times. Once you get a view
you like, select Copy from the Edit menu to copy the image to the clipboard.

Go back to Mathcad, using <Alt>-<Tab> key combination. Paste the image into your Mathcad

document
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Figure 8: The Maple V plot window with an illustration of the disk (washer) method.

To see an illustration of computing the volume of the SAME solid by the shell method, insert the
SHELLMET.MCD ¯le into your Mathcad document (make sure you ¯rst position the red crosshair
where you want the document inserted, typically BELOW your previous work).

Now switch to Maple using the <Alt>-<Tab> key combination, and load the SHELLMET.MS. Then
execute it, rotate the plot to get a view you like, and copy and paste the image back into Mathcad
as before.

The Mathcad ¯les and the corresponding Maple ¯les, can be modi¯ed to change:

² disks/washers/shells to be plotted

² total number of disks/washers/shells

² axis of revolution (parallel to the x-axis)

² functions and interval determining the region being revolved

Your instructor may give you further directions.

6.3 Activity: Arc Length

Prerequisites: Read Section 6.4 LHE (pages 432-435)
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The objective of this activity is to derive and explore the arc length formula. The meaning of
recti¯ability of curves will be addressed.
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Figure 9: A snaphot from the "Arc Length" activity template document.

Instructions

A "template" document has been created for this assignment. Before proceeding, you should read
the comments below. Unless your professor instructs you otherwise, you should load the document
ARCLEN.MCD. Follow the instructions on the screen to begin creating your lab report. Remember to
enter your team's name at the top of the document. Upon completion of the assignment, enter the
names of all team members who actively participated in the assignment. Save your work frequently.

6.4 Activity: Area of a Surface of Revolution

Prerequisites: Read Section 6.4 LHE.

Instructions

The "template" document has been created for this assignment. Unless your professor instructs
you otherwise, you should load the document SURFREV.MCD. Follow the instructions on the screen to
begin creating your lab report. Remember to enter your team's name at the top of the document.
Upon completion of the assignment, enter the names of all team members who actively participated
in the assignment. Save your work frequently.

Comments

Maple V templates, which are invoked in the course of this assignment, can be accessed by following

these steps:

² Hold the <Alt> key down, then press the <Tab> key (perhaps more than once) until the
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Figure 10: A frustum of a cone used in deriving the formula for the area of a surface of revolution.

rectangle in the center of the screen says "Program Manager", then release both keys. You
should now see the Program Manager window.

² Double-click on the "Maple V" icon.

² Once Maple starts, select Open from its File menu. Load the appropriate template ¯le.

² Read the instructions included in the Maple document and ignore the executable statements.

When you are ready to execute the ¯le, select Execute Worksheet from the Format menu.
After a while, a plot window should appear.

6.5 Homework Help

² Solution of Exercises 13-32, p.409 LHE can be supplemented with a Mathcad illustration as in
the example of Section 6.1.

² Mathcad and Maple templates discussed in Section 6.2 can be used to visualize the volumes of
revolution obtained in solving most of the exercises of Sections 6.2 and 6.3 LHE.

Surfaces of revolution can also be visualized (see Section 6.4) when working on exercises in
Section 6.4 LHE.

² Nearly all exercises in this chapter involve integration, thus you may want to consider using
Mathcad in a way similar to Problem 1 on page 53, Problem 1 on page 61, or Problem 9 on
page 63.
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7 Integration Techniques and Improper

Integrals

In Sections 5.2 and 5.3, you experienced some of the power and limitations of Mathcad's sym-
bolic processor. In particular, when using Mathcad's symbolic processor to evaluate inde¯nite and
de¯nite integrals, you should remember the following facts.

1. Mathcad's symbolic processor can antidi®erentiate the vast majority of functions encoun-
tered in calculus. However, Mathcad may obtain an expression which does not look like the
antiderivative you found by pencil and paper. To see if they're equivalent (up to an arbitrary
additive constant), have Mathcad simplify the di®erence of the two expressions.

2. (a) If your limits of integration are variable names or numbers without decimal points,

Mathcad's symbolic processor will try to ¯nd an exact symbolic or numerical value for
the integral.

(b) If you use decimals in the integrand or limits of integration, Mathcad's symbolic processor
will return a 20-place numerical value if it can evaluate the integral. For example,

d
0

3
xsin( )x yields cos( )3 1   

whereas

d
0

3.
xsin( )x yields 1.9899924966004454573  

3. Mathcad's symbolic processor may incorrectly evaluate a de¯nite integral. For example,

d
1

1

xx
2

yields 0  

since Mathcad incorrectly ¯nds that
p
x2 simpli¯es to x rather than jxj :Numerical integration

gives the approximate answer

=d
1

1

xx2 0.999999998647831  

Of course, the exact answer is 1:
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4. Mathcad incorrectly ¯nds that
R

1

xdx yields lnx rather than ln jxj : Similarly, Mathcad incor-
rectly ¯nds that

R
tan xdx yields ¡ ln cosx rather than ¡ ln jcosxj :

5. If Mathcad can't symbolically evaluate an integral, you will see the message "No closed form
found for integral" or Mathcad will simply return the same integral. Expressing the integral
in an equivalent form - by using a trigonometric identity or a u-substitution - may result
in successful integration by Mathcad. Even if a closed form solution in terms of elementary
functions doesn't exist for an integral, Mathcad may still return the solution in terms of
certain special integral functions (for examples, see Section 5.3).

6. According to Theorem 4.4 of LHE, if a function f(x) is not continuous on the closed interval
[a; b], then the de¯nite integral of f(x) may not be de¯ned on [a; b]. For example, the function
1=x has an in¯nite discontinuity at x = 0 and, in fact, the de¯nite integral of 1=x on [¡1; 2]
doesn't exist (it is a divergent improper integral). Therefore, we shouldn't expect Mathcad
to obtain a ¯nite value for this integral. Indeed, if we ask Mathcad to symbolically integrate
1=x on [-1,2], it returns the message "No closed form found for integral." If we ask Mathcad
to numerically evaluate the integral, it returns

=d

1

2

x
1

x

not converging

Similarly, if we ask Mathcad to symbolically integrate 1=x on [0,2], it returns

d

0

2

x
1

x
yields ∞   

On the other hand, Mathcad correctly evaluates the following convergent improper integral:

d

0

2

x
1

x

yields .2 2   

7. In order for Mathcad's symbolic processor to recognize the inverse trigonometric functions,
they must be typed in Mathcad form as follows:
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function Mathcad form

arcsin(x) asin( )x

arccos(x) acos( )x

arctan(x) atan ( )x

arccot(x) π atan ( )x

arcsec(x) acos
1

x

arccsc(x) asin
1

x

Note that Mathcad does not recognize acot(x), asec(x) and acsc(x) as the built-in functions
for arccot(x), arcsec(x) and arccsc(x); instead, the equivalent expressions listed above must
be used.

7.1 Activity: Integration Techniques

Prerequisites: Read Sections 7.2-7.5 LHE

In this activity, you will practice your integration skills with the help of Mathcad's symbolic pro-
cessor.

Instructions

Open a blank Mathcad document and create your report there. Remember to enter your team's
name at the top of the document. Upon completion of the assignment, enter the names of all team
members who actively participated in the assignment. Save your work frequently.

Problems

From the Symbolic menu, choose Load Symbolic Processor. Once the loading is complete, from

the same menu, choose Derivation Format. In the Derivation Format dialog

² switch "Show derivation comments" to ON (make sure a check appears in the box);

² select "Show derivation steps" horizontally.

A closed form solution in terms of elementary functions exists for each integral listed below. How-
ever, you may need to use a trigonometric identity or u-substitution before Mathcad can sym-
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bolically evaluate the integral. For each integral listed below (or the integrals speci¯ed by your
instructor), you should do the following:

(a) Ask Mathcad to symbolically evaluate the integral. If Mathcad can't evaluate the in-
tegral, state "no integral found" in your document; then (with pencil and paper) use a
trigonometric identity or u-substitution to express the integral in an equivalent form, and
have Mathcad evaluate it. In your Mathcad document, state the trigonometric identity
or u-substitution that you used. If you used a u-substitution in an inde¯nite integral,
then invoke the Substitute for Variable command to express Mathcad's answer in terms
of the original variable of integration. Verify the answer by having Mathcad di®erentiate
it symbolically - and simplify the result, if needed.

(b) Evaluate the integral using pencil and paper. (Your instructor may request that you hand

this in for grading.) If your answer looks di®erent from the one obtained by Mathcad,
then use Mathcad to verify that they're equivalent. As you evaluate the integral by hand,
you may want to have Mathcad verify your u-substitution (as suggested by Problem 9
on page 63), or verify your partial fraction expansion (by using the Convert to Partial
Fraction command from the Symbolic menu).

1.
Z

1

x3=2
p
1¡ x

dx 2.
Z

e3x

(1+ ex)3
dx

3.
Z

sec2 x

tan x (tan x¡ 1)
dx 4.

Z qp
x

1 +
p
x
dx

5.
Z p

x2 ¡ 9

x
dx 6.

Z
2x
p
2x¡ 3dx

7.

Z p
4¡ x2

2x
dx 8.

Z p
sinx cos3 xdx

9.

Z
csc
p
2xp
x

dx 10.

Z q
1+

p
xdx

11.
Z

4x¡ 2

3(x ¡ 1)2
dx 12.

Z p
xp

1 + x3
dx

13.
Z
(cotx) (ln jsin xj) dx 14.

Z
1

sec x¡ 1
dx

15.

Z
sec2 x

4 + tan2 x
dx 16.

Z p
1 + x4

x3
dx
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17.

Z b

1

p
1 + x4

x3
dx 18.

Z
sec4 x

p
tan xdx

19.

Z
arcsec

p
x dx 20.

Z
eax sin (bx) dx

7.2 Activity: Improper Integrals

This activity will improve your understanding of what it means for an improper integral to converge
or diverge.

Instructions

A "template" document IMPROPER.MCD is available for this assignment - your professor will inform
you whether you are to use it. Answer all the problems identi¯ed by your professor. Remember to

enter your team's name at the top of the document. Upon completion of the assignment, enter the
names of all team members who actively participated in the assignment. Save your work frequently.

Problems

From the Symbolic menu, choose Load Symbolic Processor. Once the loading is complete, from
the same menu, choose Derivation Format. In the Derivation Format dialog

² switch "Show derivation comments" to ON (make sure a check appears in the box);

² select "Show derivation steps" horizontally.

1. (a) Use Mathcad's symbolic processor to evaluate
R b
1

1

xpdx (b > 1). Notice that the answer
cannot be valid when p = 1: (Why?) Now, use Mathcad to show that when p = 1;R b
1

1

x
dx = lnb: Of course, the above integrals can all be done by hand. You should work

them out with pencil and paper just to make sure you can do it.

(b) By considering the limit as b!1 of your answers in part (a), explain why the improper
integral

R1
1

1

xpdx converges when p > 1 and diverges when p · 1: It follows that the
area under the curve 1

xp
on the interval [1;1) is ¯nite if and only if p > 1: What is the

value of this area?

On the same plot, graph 1

xp for p = 2;1:5; 1; 0:5;0;¡0:5 over the interval [1; 20]: Which
curve approaches the x-axis the fastest?

There is an in¯nite area under the curve 1

x on the interval [1;1): It is interesting to
observe that only a small portion of this in¯nite area is found on the ¯nite interval [1; b];
even if b is very large. For example, calculate the area for b = 10100 (which is larger than
the number of atoms in the universe). There still must be an in¯nite area under 1

x
on

the interval [10100;1) even though the curve is within 10¡100 of the x-axis.

Note: In numerical calculations, Mathcad treats 1 to be the large but ¯nite number
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10307: This is close to the largest number that can be numerically processed by Mathcad.
To see this, numerically evaluate ln b at b = 10307; 10308 and 1:

(c) Use Mathcad to show that the area under the curve 1

xp ( p > 1 ) on the interval [b;1)

is b1¡p

p¡1 : Hint: Observe that
R1
b

1

xpdx =
R1
1

1

xpdx ¡
R b
1

1

xpdx and use the results obtained

in parts (a) and (b). In particular, calculate the area under 1

x2
on [10100;1): This

illustrates that there is only a tiny amount of area under the curve 1

x2
to the right of

any very large number.

(d) According to part (b), no matter how close p gets to 1, the area under the curve 1

xp is
¯nite provided p > 1: However, the area under the curve 1

x
is in¯nite. Find the area

under 1

x1:001
on the interval [1; 10100] and on the interval [10100;1): Thus, the area under

the curve 1

x1:001
for x > 10100 is ¯nite but the area under the curve 1

x
for x > 10100 is

in¯nite.

2. (a) Use Mathcad to evaluate
R b
2

1

x lnxdx: Also work out this integral by hand (let u = lnx).
You should have obtained ln(ln b)¡ ln(ln 2); which clearly approaches in¯nity as b!1:
Thus, the area under the curve 1

x lnx over [2;1) is in¯nite and the improper integralR1
2

1

x ln xdx diverges.

(b) On the same plot, graph the two functions 1

x ln x and 1

x1:001
over the interval [2;10]: Based

on what you know about the areas under these curves, explain why 1

x ln x cannot remain
below 1

x1:001
as x!1: Eventually, the curve 1

x lnx
must intersect and remain above the

curve 1

x1:001
: In fact, the point of intersection is in the range 103955 to 103965; a number

too large for Mathcad to process!

(c) Use Mathcad to show that the area under 1

x ln x
on the large interval [2;10100] is a

relatively small number. Remember that the area under this curve from 10100 to 1 is
in¯nite. Therefore, the integral

R b
2

1

x lnx
dx monotonically increases to in¯nity as b!1;

but does so very slowly.

3. Suppose the curve 1

x is rotated about the x-axis over the interval [1;1) to obtain a 3-
dimensional object that looks like a horn. The surface area of the horn is given by

lim
b!1

Z b

1

2¼

µ
1

x

¶r
1 +

1

x4
dx:

The above integral gives the horn's surface area over the ¯nite interval [1; b]. You should be
able to derive it. If you forgot the formula for surface area, look it up and check that the

above is correct.

(a) Mathcad cannot evaluate this integral symbolically. Try it. What error message does
Mathcad give?

Now evaluate this integral numerically for b = 1000: Explain why this integral must
diverge as b!1: Therefore, the surface area of the horn is in¯nite. Hint: Compare the
integrand with 2¼

³
1

x

´
:
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(b) In part (a), you saw Mathcad could not evaluate
R b
1 2¼

³
1

x

´q
1 + 1

x4
dx: Use pencil and pa-

per to verify that the substitution u = x2 results in the equivalent integral
R b2
1 ¼

p
u2+1

u2
du

and then show that Mathcad can evaluate this integral for arbitrary b: In particular,
evaluate this integral when b = 10100 (simplify Mathcad's answer) and when "b =1".

(c) Use Mathcad to show that the improper integral which gives the volume inside the horn
over [1;1) is equal to ¼: Thus, the horn has a ¯nite volume and an in¯nite surface area!!

(d) In part (b), you used Mathcad to evaluate the integral
R b2
1

¼
p
u2+1

u2
du: In fact, you should

be able to evaluate this integral by using the integration tables in Appendix C LHE, or
by using an appropriate substitution for u. What substitution should you make for u
in order to carry out the integration? (For homework, use pencil and paper to carry

out the integration by substitution and obtain the answer that Mathcad found in part
(b). Your instructor may request that you hand this in for grading.) Which integration
formula in Appendix C LHE could you use to evaluate this integral?

(e) The expression obtained by Mathcad for the integral
R b2
1

¼
p
u2+1

u2
du in part (b) is a

function of the parameter b: Brie°y explain why the limit of this expression must be
in¯nite as b tends to in¯nity.

7.3 Homework Help

² In the numerous integration exercises of Sections 7.2-7.5 LHE, you may want to verify the
correctness of your solution, as suggested in Section 7.1 of this manual.

² Sections: 7.7 and 7.8 LHE deal with limits, thus, some of the techniques discussed in Chapter
1 of this manual may be useful.


